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3  Working with  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The skills tested in this section of the Microsoft Office Specialist exam for Microsoft 

PowerPoint 2010 relate to the graphics, sounds, and videos you can add to slides. 

Specifically, the following objectives are associated with this set of skills: 
 

3.1   Manipulate Graphical Elements 

3.2   Manipulate Images 

3.3   Modify WordArt and Shapes 

3.4   Manipulate SmartArt 

3.5   Edit Video and Audio Content 
 
 
 

These days, presentations are usually delivered electronically and often include more 

graphics than words. They might also include audio content such as music, and video 

content such as advertisements or interviews. To meet the demand for more dynamic, 

visual content, PowerPoint provides many powerful tools for working with graphics and 

multimedia. Some of these tools work with any type of graphical element, and others 

are specifically geared to a particular type. 
 
 
 
 
 
 
 
 
 
 
 

 
          365 



366       Exam 77-883   Microsoft PowerPoint 2010  

 
 

 

 
This chapter guides you in studying the common techniques for formatting any graphical 

element, as well as specific techniques for formatting images, WordArt text, shapes, 

SmartArt diagrams, videos, and sounds. 
 

 
Practice Files Before you can complete the practice tasks in this chapter, you need 
to copy the book’s practice files to your computer . The practice files you’ll use to com- 
plete the tasks in this chapter are in the PowerPoint\Objective3 practice file folder . A 
complete list of practice files is provided in “Using the Book’s Companion Content” at 
the beginning of this book . 

 

 
 

3 .1  Manipulate Graphical Elements 
 

Tip This section discusses the techniques you can use to work with all types of graphic 
elements .  For techniques that are specific to a particular type of graphic element, see  
the subsequent sections in this chapter . 

 

Opening the Format Dialog Box 

All graphical and multimedia elements have a Format dialog box that is specific to that 

type of element. Although PowerPoint provides ready-made styles and effects that you 

can apply to an element with a few clicks, it is often quicker to use this multipage dialog 

box to apply custom sets of formatting. 

 
➤ To open the Format dialog box for a graphic element 

➜  Right-click the element, and then click Format <element type>. 

 

Applying Styles, Borders, and Effects 

After you insert a picture, clip art image, SmartArt graphic, or shape, you can quickly 

change the way it looks by applying a style. Styles are one-click combinations of borders 

and effects that are appropriate to each type of graphic element. 
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In addition to applying ready-made styles, you can also apply borders and effects to 

create your own combinations. 

 
➤ To apply a style to a selected graphic element 

➜  On the Format contextual tab for the graphic element type, in the Styles gallery, 

click the thumbnail of the style you want. 

 
Tip For a SmartArt graphic, you can apply a Shape style to a selected graphic shape from 
the SmartArt Tools Format contextual tab, or you can apply a SmartArt style to the graphic 
as a whole from the SmartArt Tools Design contextual tab . 
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➤ To apply a custom border to a selected graphic element 

➜  On the Format contextual tab, in the Border palette, click the color, weight, and 

style you want. 
 

➤ To apply custom effects to a selected graphic element 

➜  On the Format contextual tab, in the Effects palette, click a type of effect, and 

then click the effect you want. 

 

Sizing and Positioning a Graphic 

You can change the size of a graphic element by dragging handles, by specifying the 

height and width, or by scaling it in proportion to its original size. 
 

You can change the orientation of many types of graphics by rotating or flipping them. 

Rotating turns the graphic 90 degrees to the right or left; flipping turns it 180 degrees 

horizontally or vertically. You can also rotate the graphic to any degree by dragging its 

green rotating handle. 
 

When a graphic is the size you want, you can position it roughly by dragging it, position 

it exactly by setting coordinates, or position it visually by using a grid and guides. 
 

The grid is a fixed matrix of horizontal and vertical dotted lines for which you can specify 

the spacing. The guides are a movable pair of horizontal and vertical lines. As you drag a 

guide, a ScreenTip shows in inches how far the guide is from the center of the slide. 
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Tip  When the Snap Objects To Grid check box is selected in the Grid And Guides  
dialog box, guides and graphics snap to the grid whether or not it is visible . 

 
 

➤ To change the size of a selected graphic element 

➜  Drag a sizing handle until the image is the shape and size you want. 

➜  On the Format contextual tab for the graphic element type, in the Size group, 

change the Shape Height or Shape Width setting. 

Or 

  1. On the Format contextual tab, click the Size dialog box launcher. 

  2. On the Size page of the Format dialog box, in the Size and rotate area, change 

the Height or Width setting. Then click Close. 

 
Tip  You cannot change the height and the width of an image disproportionately unless  
the Lock Aspect Ratio check box is cleared . 

 
 

➤ To change the scale of a selected graphic element 

➜  On the Size page of the Format dialog box, in the Scale area, change the Height or 

Width setting. Then click Close. 
 

➤ To rotate a selected graphic element 

➜  Drag the green rotating handle until the image sits at the angle you want. 

➜  On the Size page of the Format dialog box, in the Size and rotate area, change 

the Rotation setting. Then click Close. 

Or 

  1. On the Format contextual tab, in the Arrange group, click the Rotate button. 

  2. In the Rotate gallery, click the option you want. 
 

➤ To position a selected graphic element 

➜  Drag the image to the position you want. 

➜  On the Position page of the Format dialog box, change the Horizontal or Vertical 

setting and the adjacent measurement. Then click Close. 
 

➤ To display gridlines and guides to assist in positioning graphic elements 

➜  On the View tab, in the Show group, select the Gridlines or Guides check box. 

Or 
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  1. Right-click a blank area of the slide, and then click Grid and Guides. 

  2. In the Grid and Guides dialog box, select the options you want, and then click OK. 

 
Tip To quickly arrange a set of selected graphics that includes pictures, you can apply a 
SmartArt picture layout to them . Clicking Picture Layout in the Picture Styles group on 
the Picture Tools Format contextual tab displays a gallery of SmartArt picture diagrams . 
When you click a layout, PowerPoint moves the graphics into that arrangement, and you 
can then manipulate the graphics as you would the shapes in any diagram . For informa- 
tion about SmartArt, see section 3 .4, “Manipulate SmartArt .” 

 

 

Changing the Stacking Order 

When graphics overlap each other, they are stacked. The stacking order is determined by 

the order in which you inserted the graphics, but you can change it by moving graphics 

in the stack. 
 

 
Tip If you can’t select a graphic because it is covered by others in the stack, click the 
Selection Pane button in the Arrange group on the Format contextual tab to display 
the Selection And Visibility task pane, and then select the graphic you want from the 
Shapes On This Slide list . 

 
 

➤ To bring a selected graphic forward in the stack 

➜  On the Format contextual tab for the graphic element type, in the Arrange group, 

click the Bring Forward button to move the graphic forward one step at a time. 

➜  On the Format contextual tab, in the Arrange group, display the Bring Forward 

list, and then click Bring to Front to move the graphic to the top of the stack. 
 

➤ To send a selected graphic backward in the stack 

➜  On the Format contextual tab, in the Arrange group, click the Send Backward 

button to move the graphic backward one step at a time. 

➜  On the Format contextual tab, in the Arrange group, display the Send Backward 

list, and then click Send to Back to move the graphic to the bottom of the stack. 
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Grouping Graphics 

When you have multiple graphic elements on a slide, you can group them so that you can 

format, copy, and move them as a unit. You can change the attributes of an individual 

element—for example, its color, size, or location—without ungrouping the graphics. 
 

 
Tip If you click the buttons in the Images or Illustrations group on the Insert tab to add 
graphic elements to a slide that does not include a content placeholder, you can group 
them . However, if the slide does include a content placeholder, you cannot group the 
graphics no matter which method you use to insert them . 

 
 

➤ To group or ungroup selected graphic elements 

➜  On the Format contextual tab for the graphic element type, in the Arrange 

group, click the Group button, and then in the list, click Group or Ungroup. 
 

➤ To regroup graphic elements 

  1. Select one of the formerly grouped elements. 

  2. On the Format contextual tab, in the Arrange group, click the Group button, and 

then in the list, click Regroup. 

 

Aligning Graphics 
 

Strategy The alignment options can produce unexpected results when multiple images 
are selected, depending on whether Align To Slide or Align Selected Objects is turned on . 
Practice selecting the same images in different orders and then using various commands  
in the Align list to become familiar with the results . 

 

 

After inserting pictures, clip art images, shapes, or diagrams in approximate locations, 

you can align them precisely in several ways. For example, you can: 
 

● Align graphics vertically by their left or right edges or centerline, or horizontally by 

the top or bottom edges or centerline. 

● Distribute graphics evenly within their current space, either horizontally or vertically. 

● Align graphics relative to the slide that contains them or to other selected objects. 

● Align graphics relative to a position on the slide. 

● Align graphics against adjustable horizontal and vertical guides. 
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➤ To align selected graphic elements 

➜  On the Format contextual tab, in the Arrange group, click the type of alignment 

you want in the Align list. 
 

Tip  By default, a single selected graphic is aligned to the slide and multiple selected  
graphics are aligned to the first graphic selected . 

 

 

Linking Graphics to Other Information 

You can attach a hyperlink to a graphic element to provide access to supporting details. 

Clicking the hyperlinked element then takes you directly to the linked details, which might 

be on a hidden slide, in another presentation, in a file on your computer or your organiza- 

tion’s network, or on a website. To let people know the type of information that will be 

displayed when the link is clicked, you can specify text that should appear in a ScreenTip 

when they point to the linked element. 

 

 
 

 
Tip You can also use a hyperlink to open an email message window so that people view- 
ing the presentation electronically can easily contact you or your organization . 

 

 

Editing the graphic does not disrupt the hyperlink; however, deleting the graphic also 

deletes the hyperlink. 
 

 
Tip  You can attach a hyperlink to any selected object on a slide, such as text, a chart  
element, or a table . 
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➤ To link the selected graphic to a different slide 

  1. On the Insert tab, in the Links group, click the Hyperlink button. 

  2. In the Insert Hyperlink dialog box, under Link to, click Place in This Document. 

  3. In the Select a place in this document list, click the slide you want, and then 

click OK. 

 
Tip To test the hyperlink, you must be in Slide Show view or Reading view . 

 
 

➤ To link the selected graphic to a different presentation or a file 

  1. In the Insert Hyperlink dialog box, under Link to, click Existing File or Web Page. 

  2. Do one of the following, and then click OK: 

❍    With Current Folder selected, locate and click the file you want. 

❍    Click Recent Files, and then in the list, click the file you want. 
 

➤ To link the selected graphic to a webpage 

  1. In the Insert Hyperlink dialog box, under Link to, click Existing File or Web Page. 

  2. Do one of the following, and then click OK: 

❍    In the Address box, enter the URL of the webpage. 

❍    Click Browsed Pages, and then in the list, click the URL you want. 
 

➤ To link the selected graphic to an email message form 

  1. In the Insert Hyperlink dialog box, under Link to, click E-mail Address. 

  2. In the E-mail address box, enter the recipient’s address, and in the Subject box, 

enter a message subject (optional). 

  3. In the Insert Hyperlink dialog box, click OK. 
 

➤ To create a ScreenTip for a linked graphic 

  1. In the upper-right corner of the Insert Hyperlink dialog box, click ScreenTip. 

2. In the Set Hyperlink ScreenTip dialog box, in the ScreenTip text box, enter the 

text you want to appear, and then click OK. 
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Practice Tasks 

 

The practice file for these tasks is located in the PowerPoint\Objective3 practice file 

folder. If you want to save the results of the tasks, save them in the same folder with 

My appended to the file name so that you don’t overwrite the original practice file. 
 

● In the Pollution presentation, on slide 4, apply the Bevel Rectangle style and 

a gold border to the picture. Then make the picture 6 inches high by 6 inches 

wide, and position it so that its upper-left corner sits at the 3-inch mark on 

both the vertical and horizontal rulers. 

● On slide 4, make the slide title sit on top of the picture. Then bottom-align the 

arrow with the picture, and right-align the arrow with the slide. 

● On slide 4, attach a hyperlink to the picture so that clicking it displays the 

hidden slide 5. 

● On slide 5, link the graphic to the Air Pollution webpage of the Environmental 

Protection Agency’s website (www.epa.gov). Create a ScreenTip that displays 

the words Click here to find out what makes air unhealthy when someone 

points to the graphic. 
 
 
 
 

3 .2  Manipulate Images 

Cropping Images 

For pictures and clip art images, you can focus attention on a particular part of an image 

by cropping away the parts you don’t need. In addition to being able to crop free-hand, 

you can use one of several ready-made aspect-ratio settings that take the guesswork out 

of cropping, including the following: 
 

● Square (1:1) 

● Portrait ( (2:3, 3:4, 3:5, and 4:5) 

● Landscape ( (3:2, 4:3, 5:3, 5:4, 16:9, and 16:10) 

When you select an aspect ratio, PowerPoint centers a cropping frame of that ratio over the 

picture. You can then move the picture under the cropping frame so that it encompasses 

the part of the picture you want. 

http://www.epa.gov/
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You can also crop a picture to fill a picture area, to fit a picture area, or to fit any of the 

shapes in the Shape gallery. 

 

 
 

 

➤ To crop a selected image by hand 

  1. On the Picture Tools Format contextual tab, in the Size group, click the Crop 

button. 

  2. Move the cropping pointer over one of the cropping handles surrounding the 

image, and drag to crop away the parts of the image you don’t want. 

  3. Click the Crop button to turn off the cropping pointer. 
 

➤ To crop a selected image to a specific aspect ratio 

  1. On the Format contextual tab, in the Size group, display the Crop list, click Aspect 

Ratio, and then click the aspect you want. 

  2. Move the picture under the cropping frame until the frame encompasses the part 

of the image you want. 

  3. Click the Crop button to turn off the cropping frame. 
 

➤ To crop a selected image to fill or fit the current shape 

➜  On the Format contextual tab, in the Size group, display the Crop list, and click 

Fill or Fit. 
 

➤ To crop a selected image to fit a different shape 

➜  On the Format contextual tab, in the Size group, display the Crop list, click Crop to 

Shape, and then in the Shape gallery, click the shape you want. 
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Formatting Images 

After you insert a picture or clip art image into your presentation, you can modify it in 

the following ways: 
 

● Remove the background. 

● Make it sharper or softer and adjust the brightness and contrast. 
 

 
 

● Tint the image with various shades of a color, or make parts of an image 

transparent. 
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● Apply artistic effects that render the image in other styles, such as a watercolor, 

etching, or photocopy. 
 

 
 

➤ To remove the background of a selected image 

  1. On the Picture Tools Format contextual tab, in the Adjust group, click the Remove 

Background button. 

  2. If necessary, adjust the size of the rectangle outside of which the background will 

be removed. 

  3. On the Background Removal contextual tab, in the Refine group, click the Mark 

Areas to Keep, Mark Areas to Remove, or Delete Mark button, and then click 

any areas of the picture within the rectangle that you want to adjust, until the 

picture shows only the areas you want to keep. 

  4. In the Close group, do one of the following: 

❍    Click Discard All Changes to restore the background. 

❍    Click Keep Changes to remove the designated background areas from the 

picture. 

 
Tip  After removing the background from an image, you might want to crop it to reduce  
the size of the picture area . 

 
 

➤ To modify the sharpness, softness, brightness, or contrast of a selected image 

  1. On the Format contextual tab, in the Adjust group, click the Corrections button. 

  2. In the Corrections gallery, in the Sharpen and Soften or Brightness and Contrast 

areas, click the option you want. 
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➤ To change the color of a selected image 

  1. On the Format contextual tab, in the Adjust group, click the Color button. 

  2. In the Color gallery, in the Color Saturation, Color Tone, or Recolor areas, click the 

option you want. 
 

➤ To make areas of a selected image transparent 

  1. In the Color gallery, click Set Transparent Color. 

  2. In the image, click the area you want to be transparent. 
 

➤ To apply artistic effects to a selected image 

  1. On the Format contextual tab, in the Adjust group, click the Artistic Effects button. 

  2. In the Artistic Effects gallery, click the desired effect. 

 

Compressing Pictures 

Picture-intensive presentation files can be quite large. You might want to compress the 

pictures to make the presentation file smaller and more portable. 

 

 
 

➤ To compress a selected picture 

  1. On the Picture Tools Format contextual tab, in the Adjust group, click the Compress 

Pictures button. 

  2. In the Compress Pictures dialog box, do one of the following, and then click OK: 

❍    Select the Apply only to this picture check box to compress only the active 

picture, or clear it to compress all pictures in the presentation. 

❍    Select the Delete cropped areas of pictures check box to delete the pixels you 

crop away, or clear the check box to only hide them. 

❍    Click the resolution (in pixels per inch, or ppi) best suited to your target output. 
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Resetting or Replacing Images 

If you don’t like the changes you have made to an image, you can easily restore the 

original image. If you decide to try a different image, you can simply replace it. 

 
➤ To discard changes to a selected image 

➜  To discard changes other than sizing, on the Picture Tools Format contextual tab, 

in the Adjust group, click the Reset Picture button. 

➜  To discard all changes, including sizing, display the Reset Picture list, and then 

click Reset Picture & Size. 
 

➤ To replace a selected image 

  1. On the Format contextual tab, in the Adjust group, click the Change Picture 

button. 

  2. In the Insert Picture dialog box, locate and double-click the replacement 

picture. 
 

 

Practice Tasks 
 

The practice file for these tasks is located in the PowerPoint\Objective3 practice file 

folder. If you want to save the results of the tasks, save them in the same folder with 

My appended to the file name so that you don’t overwrite the original practice file. 
 

● In the PhotoAlbum presentation, on slide 2, crop both pictures to a portrait 

aspect ratio of 2:3, with the flowers centered. Then size and position them 

so that they take up most of the slide. 

● On slide 2, increase the contrast of both pictures by 20 percent. 

● On slide 3, crop both images to a square aspect ratio, with the flowers 

centered. Then size and position them so that they are evenly distributed 

on the slide. 

● On slide 3, remove the background of both pictures. Then make the flower 

on the left look like a line drawing and the flower on the right look like a 

smooth pastel sketch. 
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3 .3  Modify WordArt and Shapes 

Working with WordArt 

If you want to add a fancy title to a slide and you can’t achieve the effect you want with 

regular text formatting, you can use WordArt to create stylized text in various shapes. 

WordArt text can be stretched horizontally, vertically, or diagonally to shape it in fan- 

tastic ways. You can also apply additional formatting to achieve unique effects. 

 

 
 

 

➤ To create WordArt text 

  1. On the Insert tab, in the Text group, click the WordArt button. 

  2. In the WordArt gallery, click the style you want. 

  3. In the text box, enter your text. 
 

➤ To apply a different style to selected WordArt text 

➜  On the Drawing Tools Format contextual tab, in the WordArt Styles group, display 

the WordArt Styles gallery, and then click the style you want to apply. 

 
Tip You can apply a WordArt style to any text . 
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➤ To add special effects to selected WordArt text 

  1. On the Format contextual tab, in the WordArt Styles group, click the Text Effects 

button. 

  2. In the Text Effects gallery, click an effect category, and then choose the one you want. 
 

➤ To change the shape of selected WordArt text 

  1. On the Format contextual tab, in the WordArt Styles group, click the Text Effects 

button, and then click Transform. 

  2. In the Transform gallery, click the shape you want. 

  3. Size and position the WordArt object the same way you would size and position 

any other text box. 

  4. To exaggerate the shape, drag the purple diamond handle to achieve the effect 

you want. 

 
Tip You can use text effects to format and change the shape of any text . 

 
 

➤ To remove WordArt styling from selected text 

➜  On the Format contextual tab, in the WordArt Styles group, display the WordArt 

Styles gallery, and then click Clear WordArt. 

 

Working with Shapes 

To emphasize key points in a presentation, you can draw shapes, including stars, banners, 

boxes, lines, circles, and squares. You can also combine shapes to create simple illustrations. 
 

 
Tip You can create a copy of a selected shape by dragging it while holding down the 
Ctrl key . 

 

 

After drawing a shape, you can format it by using the same techniques you would use to 

format a text box. The quickest way to apply an eye-catching combination of formatting 

is to use a style. If you format a shape and then want all subsequent shapes you draw in 

the same presentation to have the same formatting, you can set the formatting combi- 

nation as the default. 
 

 
See Also For information about formatting text boxes, see section 2 .6, “Format Text Boxes .” 
For information about using styles, see section 3 .1, “Manipulate Graphical Elements .” 

 

 

You can add text to a shape and then format it the same way you would format any text, 

including by applying a WordArt style to it. 
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If you want to show a relationship between two shapes, you can connect them with a line 

by joining special handles called connection points. Moving a connected shape also moves 

the line, maintaining the relationship between the connected shapes. 

 

 
 

 

➤ To draw a shape 

  1. On the Insert tab, in the Illustrations group, click the Shapes button. 

  2. In the Shapes gallery, click the shape you want. 

  3. Move the crosshair pointer to the position on the slide where you want the upper- 

left corner of the shape to be, and drag down and to the right to draw a shape the 

size you want. 

 
Tip  To draw a circle or a square, click the Oval or a Rectangle shape, and hold down  
the Shift key while you drag . 

 
 

➤ To change to a different shape 

  1. With the shape selected, on the Drawing Tools Format contextual tab, in the Insert 

Shapes group, click the Edit Shape button. 

  2. Click Change Shape, and then in the Shapes gallery, click the shape you want. 
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Tip  If a shape has a yellow diamond handle, you can drag this handle to alter the  
appearance of the shape without changing its size or angle of rotation . 

 
 

➤ To make the formatting of the selected shape the default for future shapes 

➜  Right-click the shape, and click Set as Default Shape. 
 

➤ To add text to a selected shape 

  1. On the Format contextual tab, in the Insert Shapes group, click the Text Box 

button. 

  2. Click the shape, and then enter the text. 
 

➤ To connect two shapes 

  1. In the Shapes gallery, under Lines, click one of the connector shapes. 

  2. Point to the first shape, point to a connection point, drag to the second shape, and 

when its connection points appear, release the mouse button over one of the points. 

 
Tip Connection points are red .  If a blue handle appears instead of a red one, the shapes 
are not connected . Click the Undo button on the Quick Access Toolbar to remove the 
connection line, and then redraw it . 

 

 
 

Practice Tasks 
 

The practice file for these tasks is located in the PowerPoint\Objective3 practice file 

folder. If you want to save the results of the tasks, save them in the same folder with 

My appended to the file name so that you don’t overwrite the original practice file. 
 

● In the ManagingYourTime presentation, on slide 1, convert the title into a 

WordArt object by applying the Gradient Fill – Dark Red, Accent 6, Inner 

Shadow style. 

● On slide 1, mold the WordArt title into an upside-down triangle, with a full 

reflection offset by 8 points. 

● On slide 2, add the word Time to the arrow on the left and the word Money 

to the arrow on the right. Format the words with the same WordArt style as 

the presentation title. 

● On slide 2, use an Elbow Connector to connect the left arrow’s bottom point 

with the right arrow’s bottom point. Then increase the height of the right 

arrow to 4 inches. 
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3 .4  Manipulate SmartArt 

Creating Diagrams 
 

Strategy Get to know the kinds of diagrams you can create so that you can quickly 
pinpoint a specific type in the Choose A SmartArt Graphic dialog box .  In particular, 
know the locations of all the diagrams whose names are preceded by Basic . 

 

 

When you want to illustrate a process or the relationship between hierarchical elements, 

you can create a dynamic, visually appealing diagram by using SmartArt graphics. By using 

predefined sets of formatting, you can almost effortlessly put together the type and style 

of diagram that best conveys your information, such as the following: 
 

●    List Shows groups of multilevel sequential or nonsequential information. 
 

●    Process Visually describes the ordered set of steps required to complete a task or 

workflow. 
 

●    Cycle Represents a circular sequence of steps, tasks, or events; or the relationship 

of a set of steps, tasks, or events to a central, core element. 
 

●    Hierarchy Illustrates the structure of an organization or entity. 
 

●    Relationship Shows convergent, divergent, overlapping, merging, or containing 

elements. 
 

●    Matrix Shows items or concepts as they relate to the whole. 
 

●    Pyramid Shows proportional, interconnected, or hierarchical relationships in a triangle. 
 

●    Picture Creates a layout in which you can insert graphics, optionally with captions. 
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You can easily convert an ordinary bulleted list to a SmartArt diagram that retains 

the relationship of the bullet levels. Or you can create the diagram and then add text, 

either directly to its shapes or as a bulleted list in the text pane that opens to the left 

of the diagram. In this text pane, you can add shapes, delete shapes, and rearrange 

them by dragging them. 

 
➤ To create a SmartArt diagram from a bulleted list 

➜  Right-click any item in the list, point to Convert to SmartArt, and then in the gallery, 

click the diagram you want. 
 

➤ To create an empty SmartArt diagram 

  1. On a slide that contains a content placeholder, click the Insert SmartArt Graphic 

button. 

Or 

On the Insert tab, in the Illustrations group, click the SmartArt button. 

  2. In the left pane of the Choose a SmartArt Graphic dialog box, click the category 

you want. 

  3. In the center pane, click the desired layout. 

  4. Click OK. 
 

➤ To add text to a SmartArt diagram 

➜  Click a shape, and then enter the text. 

Or 

  1. Open the Text pane by doing one of the following: 

❍    Click the button on the left side of the diagram’s frame. 

❍    On the SmartArt Tools Design contextual tab, in the Create Graphic group, 

click the Text Pane button. 

  2. Replace the bullet point placeholders with your own text. 
 

➤ To add a shape 

➜  In the Text pane, at the right end of the bullet after which you want to add the 

shape, press Enter, and enter the text for the new shape. 

➜  Click the shape after which you want to add the shape, and then on the Design 

contextual tab, in the Create Graphic group, click the Add Shape button. 
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Tip To add a shape before the selected shape, display the Add Shape list, and then click 
Add Shape Before . 

 
 

➤ To promote a subordinate point to a shape or demote a shape to a subordinate  

point 

➜  Click the subordinate point or shape, and then on the Design contextual tab, in 

the Create Graphic group, click the Promote or Demote button. 

 
Tip Some SmartArt diagrams are not formatted to accept subordinate points within 
shapes .  In hierarchical diagrams, adding a subordinate point in the Task pane adds  
a subordinate shape, not a bullet point . 

 
 

➤ To move an existing shape 

➜  Click the shape, and then on the Design contextual tab, in the Create Graphic group, 

click the Move Up or Move Down button. 
 

➤ To delete a selected shape 

➜  Press the Delete key. 

 

Making Design Changes 

You can customize a diagram as a whole by making changes such as the following: 
 

● Switch to a different layout of the same type or a different type. 

 
Tip  If the text in the original diagram doesn’t fit in the new layout, the text is not  
shown .  However, it is retained so that you don’t have to retype it if you switch again . 

 
● Switch the direction of the layout. 

● Add shading and three-dimensional effects to all the shapes in a diagram. 

● Select a different combination of colors that coordinates with the presentation’s 

color scheme. 

● Apply fancy formatting to the text in all the shapes. 

 
See Also For information about changing the style and adding shading and effects, see 
section 3 .1, “Manipulate Graphical Elements .” For information about formatting the text 
in shapes, see section 3 .3 Modify WordArt and Shapes .” 
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➤ To change the layout of a selected diagram 

➜  On the SmartArt Tools Design contextual tab, in the Layouts gallery, click the 

layout you want. 

 
Tip To switch to a different layout category, click More Layouts at the bottom of 
the gallery, and then in the Choose A SmartArt Graphic dialog box, click the desired 
category and layout . 

 
 

➤ To switch the direction of a selected diagram 

➜  On the Design contextual tab, in the Create Graphic group, click the Right to 

Left button. 
 

➤ To change the color of shapes 

  1. On the Design contextual tab, in the SmartArt Styles group, click the Change 

Colors button. 

  2. In the Colors gallery, click the color scheme you want. 

 

Changing Shapes in Diagrams 

In addition to formatting a SmartArt diagram as a whole, you can select an individual 

shape in a diagram and change it in various ways, including increasing or decreasing 

its size, altering its form, and changing its color, outline, and effect. In general, you can 

format the shape and the text within it by using the same formatting techniques you 

would use for text boxes. 
 

 
See Also For information about formatting text boxes and their text, see section 2 .6, 
“Format Text Boxes .” 

 
 

➤ To change a selected shape 

  1. On the SmartArt Tools Format contextual tab, in the Shapes group, click the Change 

Shape button. 

  2. In the Shape gallery, click the shape you want. 
 

➤ To make a selected shape larger or smaller 

➜  On the Format contextual tab, in the Shapes group, click the Larger or Smaller 

button. 

➜  On the Format contextual tab, in the Size group, change the Height or Width 

setting. 
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Tip After customizing a diagram, you can revert to the original format by clicking the 
Reset Graphic button in the Reset group on the SmartArt Tools Design contextual tab . 

 

 

Converting Diagrams to Shapes or Bullet Points 

Just as you can convert a bulleted list to a SmartArt diagram, you can convert a diagram 

to a bulleted list. You can also convert it to a set of independent shapes. 

 
➤ To convert a selected SmartArt diagram to a bulleted list 

➜  On the SmartArt Tools Design contextual tab, in the Reset group, click the Convert 

button, and then click Convert to Text. 
 

➤ To convert a selected SmartArt diagram to a set of independent shapes 

  1. On the Design contextual tab, in the Reset group, click the Convert button, and 

then click Convert to Shapes. 

  2. On the Drawing Tools Format contextual tab, in the Arrange group, click the 

Group button, and then click Ungroup. 
 

 

Practice Tasks 
 

The practice file for these tasks is located in the PowerPoint\Objective3 practice file 

folder. If you want to save the results of the tasks, save them in the same folder with 

My appended to the file name so that you don’t overwrite the original practice file. 
 

● In the StatusMeeting presentation, on slide 3, insert an Organization Chart 

diagram. Then enter Florian Stiller as the boss, Tali Roth as Florian’s assistant, 

and Ryan Danner, Nate Sun, and Erin Hagens as Florian’s subordinates. 

● On slide 3, delete the shape for Florian Stiller’s assistant from the organization 

chart. Then assign Florian another subordinate named Lukas Keller. 

● On slide 4, convert the bulleted list to a Continuous Block Process diagram. 

Then change the layout to Basic Venn. 

● On slide 4, change the style of the diagram to 3-D Polished, and change the 

colors to Colorful – Accent Colors. Then format the text as Fill – White, Drop 

Shadow. Finally, change the color of the Administration & HR shape to Dark Red. 
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3 .5  Edit Video and Audio Content 

Inserting and Editing Video Content 

Sometimes the best way to ensure that your audience understands your message is to show 

a video. You can insert the following types of videos in slides: 
 

●    Video files You can insert a digital video that has been saved as a file. 
 

●    Videos from websites If a video on a public website is in a format supported by 

Windows Media Player and the owner of the video has made it available to the 

public, you can insert a link to the video into a slide. Provided the video remains 

available in its original location, and provided you have an active Internet connec- 

tion, you will be able to access and play the video from the slide. 
 

●    Clip art videos Clip art videos are animated graphics, rather than real videos. When 

you insert a clip art video, it appears as a picture on the slide, and PowerPoint adds a 

Format contextual tab to the ribbon so that you can adjust the way the picture looks. 

The clip moves only when you display the slide in Reading view or Slide Show view, 

and you cannot adjust its action. 
 

After you add a video object, its first frame appears on the slide. When the video object 

is selected, a play bar appears below it with controls for playing the video. 
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You can change the way the video object appears on the slide as follows: 

 

● Drag the object to locate it anywhere on the slide. 

● Drag its sizing handles to make it larger or smaller. 

● Change its appearance by adding styles, frames, and effects. 

You can also customize the video so that it plays when and how you want. 

 
➤ To insert a video file 

  1. If a slide’s layout includes a content placeholder, click the Insert Movie Clip button. 

  2. In the Insert Video dialog box, locate and double-click the video file you want. 

Or 

  1. On the Insert tab, in the Media group, click the Video button. 

  2. In the Insert Video dialog box, locate and double-click the video file you want. 
 

➤ To insert a video from a website 

  1. Display the video you want to use, right-click it, and then click Copy embed html. 

 
Tip If you don’t see this command, you cannot insert this video into the slide, either 
because it is the wrong format or because the owner has not made it available for 
public use . 

 
  2. Display the slide into which you want to insert the video. 

  3.  On the Insert tab, in the Media group, display the Video list, and then click Video  

from Web Site. 

  4. In the Insert Video from Web Site dialog box, click in the text box, and then press 

Ctrl+V (the keyboard shortcut for the Paste command). 

  5. Click OK. 
 

➤ To insert a clip art video 

  1. On the Insert tab, in the Media group, display the Video list, and then click Clip 

Art Video. 

  2. In the Clip Art task pane, search for and click the video clip you want. 

  3. Click the arrow that appears to the right of the clip, and then click Insert. 
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➤ To play the video in Normal view 

➜  Click the video object, and then do either of the following: 

❍    On the object’s play bar, click the Play/Pause button. 

❍    On the Video Tools Format or Playback contextual tab, in the Preview group, 

click the Play button. 
 

➤ To change the appearance of a selected video object 

➜  Use the commands on the Video Tools Format contextual tab to format the video 

object just as you would a picture. 

 
See Also For information about using styles and sizing or positioning video objects, see 
section 3 .1, “Manipulate Graphical Elements .” For information about formatting pic- 
tures, see section 3 .2, Manipulate Images .” 

 
 

➤ To change the settings for a selected video object 

➜  On the Video Tools Playback contextual tab, in the Video Options group, do any 

of the following: 

❍    Click the Volume button to adjust the volume to low, medium, or high, or to 

mute the sound. 

❍    Specify whether the video plays automatically when the slide appears or only 

if you click it. 

❍    Select the Play Full Screen check box to expand the video to fill the screen. 

❍    Select the Hide While Not Playing check box to make the video object invis- 

ible while it is not active. For example, if a video plays automatically when its 

slide is displayed, you can choose this option to hide the video object when it 

has finished playing. 

❍    Select the Loop until Stopped check box to have the video play continuously 

until you stop it. 

❍    Select the Rewind after Playing check box to ensure that the video starts 

from the beginning each time it is played. 



392       Exam 77-883   Microsoft PowerPoint 2010  

 
 

 

 
➤ To edit a selected video object 

➜  On the Video Tools Playback contextual tab, in the Editing group, do any of the 

following: 

❍    Click the Trim Video button to edit the video so that only part of it plays. 

 
Tip You can find out the total playing time of a video by displaying the Trim 
Video dialog box . 

 

 
❍    Specify Fade In and Fade Out settings to have the video gradually appear 

and disappear. 

 

Inserting and Editing Audio Content 

You can insert the following types of sounds: 
 

●    Audio files You can insert an audio file such as a speech or an interview. 
 

●    Audio clips The audio clips that ship with PowerPoint, which include applause and 

a phone ring, are available from the Clip Art task pane. You can also download hun- 

dreds of sounds from Office Online. 
 

●    Recorded sounds You can record a sound or narration and attach it to a slide, all 

from within PowerPoint. 
 

After you add an audio object, it appears on the slide represented by an icon. When the 

audio object is selected, a play bar appears below its icon with controls for playing 

the sound. 
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You can change the icon as follows: 

 

● Drag the object to locate it anywhere on the slide. 

● Drag its sizing handles to make it larger or smaller. 

● Change its appearance by applying styles, borders, and effects. 

● Replace the default icon with a picture. 

You can also customize the sound so that it plays when and how you want. 

 
➤ To insert an audio file 

  1. On the Insert tab, in the Media group, click the Audio button. 

  2. In the Insert Audio dialog box, locate and double-click the audio file you want. 
 

➤ To insert an audio clip 

  1. On the Insert tab, in the Media group, display the Audio list, and then click Clip 

Art Audio. 

  2. In the Clip Art task pane, search for and click the sound you want. 

  3. Click the arrow that appears to the right of the sound, and then click Insert. 
 

➤ To attach a sound or narration to a selected slide 

 
Tip  You must have a sound card, microphone, and speakers installed to record and test  
sounds .  Test the microphone before beginning the recording . 

 
  1. On the Insert tab, in the Media group, display the Audio list, and then click Record 

Audio. 

  2. In the Record Sound dialog box, click the Record button, record the sound or your 

comments, and then click the Stop button. 

  3. Name the sound or narration, and then click OK. 

 
See Also For information about recording an entire presentation, see section 8 .4, 
“Record Presentations .” 
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➤ To play the sound in Normal view 

 
Tip You must have a sound card and speakers installed to play sounds . 

 
➜  Click the audio icon, and then do either of the following: 

❍    On the icon’s play bar, click the Play/Pause button. 

❍    On the Audio Tools Playback contextual tab, in the Preview group, click the 

Play button. 
 

➤ To change the appearance of a selected audio icon 

➜  Use the commands on the Audio Tools Format contextual tab to format the audio 

object just as you would a picture. 

 
See Also For information about using styles and sizing or positioning audio objects, see 
section 3 .1, “Manipulate Graphical Elements .” For information about formatting pic- 
tures, see section 3 .2, Manipulate Images .” 

 
 

➤ To change the settings for a selected audio object 

➜  On the Audio Tools Playback contextual tab, in the Audio Options group, do any 

of the following: 

❍    Click the Volume button to adjust the volume to low, medium, or high, or to 

mute the sound. 

❍    Specify whether the sound plays when the slide appears (Automatically), only 

if you click its icon (On Click), or throughout the presentation (Across Slides). 

❍    Select the Hide During Show check box to make an audio object that plays 

automatically invisible while the presentation is displayed in Reading view or 

Slide Show view. 

❍    Select the Loop until Stopped check box to have the sound play continuously 

until you stop it. 

❍    Select the Rewind after Playing check box to ensure that the sound starts 

from the beginning each time it is played. 
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➤ To edit the sound for a selected audio object 

➜  On the Playback contextual tab, in the Editing group, do any of the following: 

❍    Click the Trim Audio button to edit the sound so that only part of it plays. 

❍    Specify Fade In and Fade Out settings to have the sound gradually increase 

and decrease in volume. 

 
Practice Tasks 

 

The practice files for these tasks are located in the PowerPoint\Objective3 practice file 

folder. If you want to save the results of the tasks, save them in the same folder with 

My appended to the file name so that you don’t overwrite the original practice files. 
 

● In the InMyBackyard presentation, on slide 1, insert the Bear video file from 

your practice file folder. In Normal view, play the video. 

● On slide 1, increase the video’s brightness and contrast by 20 percent. Then 

apply the Bevel Rectangle style. Finally, make the video start playing auto- 

matically when the presentation is launched and make it play as long as the 

slide is on the screen. 

● In the ShareholdersMeeting presentation, on slide 4, insert any audio clip of 

audience applause (for example, Cheers In Hall). 

● On slide 4, use the Bravo image in your practice file folder to represent the 

audio object. Make the image about 2 inches tall, and move it to the lower- 

right corner of the slide. Then set the sound to play continuously after the 

icon is clicked. 
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Objective Review 
 

Before finishing this chapter, ensure that you have mastered the following skills: 
 

3.1   Manipulate Graphical Elements 

3.2   Manipulate Images 

3.3   Modify WordArt and Shapes 

3.4   Manipulate SmartArt 

3.5   Edit Video and Audio Content 



 

 
 

5  Managing  
    Calendar Objects 

 
 
 

The skills tested in this section of the Microsoft Office Specialist exam for Microsoft 

Outlook 2010 relate to creating and managing appointments, events, and meetings, 

and displaying information in the Calendar pane. Specifically, the following objectives 

are associated with this set of skills: 
 

5.1   Create and Manipulate Appointments and Events 

5.2   Create and Manipulate Meeting Requests 

5.3   Manipulate the Calendar Pane 
 
 
 

Outlook 2010 provides full calendar and scheduling functionality to help you manage 

business and personal appointments, meetings, and events. Knowing how to use the 

calendar effectively can help you stay organized, on task, and on time. 
 

This chapter guides you in studying ways of creating and customizing Outlook calen- 

dar items, scheduling meetings and managing meeting requests, customizing your 

Calendar settings to fit the way you work, and displaying different views of one or 

more calendars. 
 

 
Practice Files Before you can complete the practice tasks in this chapter, you need 
to copy the book’s practice files to your computer . The practice files you’ll use to com- 
plete the tasks in this chapter are in the Outlook\Objective5 practice file folder .  A 
complete list of practice files is provided in “Using the Book’s Companion Content” 
at the beginning of this book . 

 

 
 
 
 
 
 
 
 
 
 
 
 

          603 
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5 .1  Create and Manipulate Appointments and Events 

Scheduling Appointments 

Appointments are blocks of time you schedule for only yourself (as opposed to meetings, to 

which you invite other Outlook users). An appointment has a specific start time and a specific 

end time (as opposed to an event, which occurs for one or more full 24-hour periods). 
 

You can enter an appointment directly in the Calendar pane, in which case the time is 

shown on your calendar as Busy and the appointment reminder is set to 15 minutes. If 

you want to change those default settings, or if you want to schedule an appointment 

to start or end at a time that does not fit the default half-hour increments shown in the 

Calendar pane, you can enter the appointment in an appointment window. 

 

 
 

Time scheduled for an appointment can be shown as Free, Tentative, Busy, or Out Of 

Office. You can change the reminder time or turn it off completely. You can also include 

information such as driving directions or website links in the content pane, and attach 

related files so that they are easily available to you at the time of the appointment. 
 

 
Tip If you synchronize your Outlook installation with a mobile device such as a Windows 
Phone, an iPhone, or a BlackBerry, you can also receive reminders on your device . 

 

 

You can also create an appointment based on an email message or task simply by dragging 

it to the Calendar button in the Navigation Pane. When you release the mouse button, an 

appointment window opens with the message or task subject as the appointment subject 

and the message or task details in the appointment window’s content pane. The start and 

end times are set to the next half-hour increment following the current time. You can then 

make any necessary adjustments before saving the appointment. 



  5    Managing Calendar Objects  605  

 
 

 
 
 

Tip When you create an appointment based on an email message, the appointment 
window might open behind the Outlook program window .  Click the Outlook button 
on the Windows taskbar and then click Untitled - Appointment to display the new  
appointment window . 

 

 
Tip You can convert an appointment to a meeting by opening the appointment window, 
clicking the Scheduling Assistant button in the Show group on the Appointment tab, and 
then adding one or more attendees .  For more information, see section 5 .2, “Create and 
Manipulate Meeting Requests .” 

 
 

➤ To create an appointment with default settings 

  1. In the Calendar pane, click the desired time slot, or drag through consecutive 

time slots. 

  2. Enter the information you want to appear as the appointment subject, and then 

press Enter. 
 

➤ To create an appointment with custom settings 

  1. In the Calendar module, on the Home tab, in the New group, click the New 

Appointment button. 

  2. In the appointment window, enter the information you want to appear on the 

calendar in the Subject and Location boxes. 

  3. Click the appointment start date in the left Start time list and, if the appointment 

extends across multiple days, click the appointment end date in the left End time list. 

  4. Click or enter the appointment start time in the right Start time list and the 

appointment end time in the right End time list. 

  5. On the Appointment tab, in the Options group, click your availability during 

the specified appointment time—Free, Tentative, Busy, or Out of Office—in the 

Show As list. 

  6. In the Options group, in the Reminder list, click the length of time prior to the 

appointment (or None) when you would like Outlook to display an appointment 

reminder. 

 
Tip You can specify the sound to play for reminders by clicking Sound at the bottom of 
the Reminder list and then browsing to the sound file you want to use . You can re- 
move the sound effect from reminders by clicking Sound and then clearing the Play 
This Sound check box . 

 
  7. Add notes about the appointment in the content pane. 
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Tip To attach a file to an appointment or event, click the Attach File button in the 
Include group on the Insert tab, and then browse to and double-click the file . 

 
  8. On the Appointment tab, in the Actions group, click the Save & Close button. 

 

➤ To change the time of an existing appointment 

➜  In the Calendar pane, drag the appointment to a different date or to a different 

time slot. 

➜  In the Calendar pane, in Day view, Work Week view, or Week view, drag the top or 

bottom border of the appointment up or down to change the start or end time. 

➜  In the Calendar pane, click the appointment one time to select it, press Ctrl+X, click 

the time slot to which you want to move the appointment, and then press Ctrl+V. 

➜  In the appointment window, adjust the Start date, End date, Start time, and End 

time settings. Then on the Appointment tab, in the Actions group, click the Save & 

Close button. 
 

➤ To create an appointment from an email message 

  1. In the Mail module, drag the message from the Mail pane to the Calendar button 

at the bottom of the Navigation Pane. 

  2. In the appointment window that opens, edit the appointment details as necessary. 

  3. On the Appointment tab, in the Actions group, click the Save & Close button. 

 

Scheduling Events 

Events are day-long blocks of time that you schedule on your calendar. In all other 

respects, events are identical to appointments. In Day, Work Week, or Week view, 

events are shown in the space below the header, above the schedule for the day. In 

Month view, events are shown above appointments and meetings. 

 

 
 

You can enter an event directly in the Calendar pane, in which case the time is shown 

on your calendar as Free and the event reminder is set to 15 minutes. You can change 

those settings by opening the event window. 
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You can create an event from an email message or task by first creating an appointment 

and then converting it to an event. 

 
➤ To create an event with default settings 

  1. In the Calendar module, display the date on which you want to schedule the event in 

Day view, Work Week view, or Week view. 

  2. At the top of the Calendar pane, click (don’t double-click) the space between the 

header and the first time slot. 

 
Tip Click to add event appears in the space when you point to the correct space . 

 

  3. Enter the event subject, and then press Enter. 

Or 

  1. Display the Calendar module in Month view. 

  2. Click an empty area of the cell below the header of the date on which you want to 

schedule the event. 

 
Tip  The cell color changes to indicate that the date is selected, but no text indicator  
appears . 

 

  3. Enter the event subject, and then press Enter. 
 

➤ To create an event with custom settings 

  1. In the Calendar module, display the date on which you want to schedule the event. 

  2. In Day view, Work Week view, or Week view, double-click the space between the 

header and the first time slot. 

Or 

In Month view, double-click the cell below the date header. 

 
Tip You can also open a new event window by clicking All Day Event on the New 
Items menu without first clicking the space above the time slots . 

 
  3. In the Untitled - Event window that opens, fill in the Subject and Location boxes 

and set the Show As and Reminder options. 

  4. On the Event tab, in the Actions group, click the Save & Close button. 

 
Strategy Practice creating appointments, meetings, and events from scratch and 
from email messages; then practice changing a calendar item from one type to another, 
changing its details, and attaching files to it . 
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Setting Recurrence and Privacy Options 

If an appointment, event, or meeting will happen more than once at specific intervals, such 

as every Tuesday or every month, you can set it up as a recurring appointment, event, or 

meeting series. Outlook then creates multiple instances of the appointment in your calen- 

dar at the time interval you specify. Calendar items in a recurring series are linked; if you 

need to make changes, you can choose to update a specific occurrence or all occurrences. 
 

 
 

You can mark any item in your calendar as Private. Then when other people look at your 

calendar, they can see that you are free, busy, or out of the office, but they can’t see why. 
 

 

 
➤ To mark a Calendar item as private 

➜  In the item window, on the Appointment, Event, or Meeting tab, in the Tags 

group, click the Private button. 
 

➤ To create a recurring Calendar item 

  1. In the item window, on the Appointment, Event, or Meeting tab, in the Options 

group, click the Recurrence button. 
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  2. In the Recurrence pattern area of the Appointment Recurrence dialog box, click 

a frequency option. 

  3. In the adjacent area, which changes according to the frequency option you select, 

adjust the settings to reflect the desired recurrence. 

  4. In the Range of recurrence area, select the appropriate end date for the series of 

appointments or events. 

  5. Click OK. 
 

➤ To cancel the recurrence of a Calendar item 

  1. In the Calendar pane, click (don’t double-click) the item. 

  2. On the Calendar Tools Appointment Series, Event Series, or Meeting Series 

contextual tab, in the Options group, click the Recurrence button. 

  3. In the Appointment Recurrence dialog box, click the Remove Recurrence button. 

 
Strategy  Practice creating private appointments on your calendar; then ask a coworker  
to verify that he or she can’t see the appointment details in Outlook . 

 
 

➤ To edit one or all occurrences of a recurring Calendar item 

  1. In the Calendar pane, double-click the recurring item. 

  2. In the Open Recurring Item dialog box, click Open this occurrence to edit only 

the item you clicked, or click Open the series to edit all occurrences in the series. 

Then click OK. 

 

Working with Appointments and Events 

To share information about an appointment or event, without specifically creating a 

meeting and inviting people to the meeting as attendees, you can forward the appoint- 

ment or event information as an email attachment or you can distribute a printout of 

the appointment or event information. 

 
➤ To forward an appointment or event 

  1. In the appointment or event window, on the Appointment or Event tab, in the 

Actions group, do one of the following: 

❍    Click the Forward button to create an email message that has the appointment 

or event attached as an Outlook item. 

❍    Click the Forward arrow and then click Forward as iCalendar to create an email 

message that has the appointment or event attached as an iCalendar file. 
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Tip  You can forward an appointment or event as an iCalendar attachment to people  
who use email programs other than Outlook . 

 

  2. Address and send the email message. 
 

➤ To print appointment or event details 

  1. Open the appointment or event window. 

  2. On the Print page of the Backstage view, specify the print options you want, and 

then click the Print button. 
 

 

Practice Tasks 
 

The practice file for these tasks is located in the Outlook\Objective5 practice file folder. 
 

● Display tomorrow’s date in the Calendar pane. Create a half-hour appoint- 

ment from 11:30 A.M. to 12:00 P.M., with the subject MOS Lunch with Jane. 

Accept all other default settings. 

● Without opening the appointment window, change the start time of the MOS 

Lunch with Jane appointment to 10:30 A.M and the end time to 11:30 A.M. 

● Specify the location of the MOS Lunch with Jane appointment as Fourth 

Coffee, and set a reminder to appear at 9:30 A.M. Set the appointment 

options so that other Outlook users see that you will be out of the office 

from 10:30 A.M. to 11:30 A.M. but can’t see any appointment details. 

● Create a recurring one-hour appointment on the first Monday of the month 

at 6:00 P.M. with the subject MOS Book Club. Set the series to end after six 

occurrences. 

● Create a two-day event on Tuesday and Wednesday two weeks from now in 

Portland, Oregon, with the subject MOS Annual Meeting and Retreat. Attach 

the Agenda document to the event. 

● Forward the MOS Annual Meeting and Retreat event information to yourself 

as an email message attachment. 
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5 .2  Create and Manipulate Meeting Requests 

Creating Meeting Requests 

You can send a meeting invitation (referred to as a meeting request) to any person who 

has an email account (even to people who don’t use Outlook). You can let people 

who don’t have to attend the meeting know that it is taking place by marking their 

attendance as optional. The meeting request can include text and web links, as well as 

file attachments to ensure that attendees have specific information available to them. 

 

 
 

Meeting requests include two pages: the Appointment page and the Scheduling 

Assistant page. You can change the date and time and invite attendees on either 

page. You can specify whether a specific attendee is required or optional on the 

Scheduling Assistant page. 
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See Also For information about the Scheduling Assistant page, see “Scheduling 
Meetings” later in this section . 

 

 

By default, meeting requests that you send include a standard set of response options 

that allow meeting request recipients to accept, tentatively accept, or decline the meeting 

request; to propose a new meeting time; to reply to the meeting organizer or to all 

attendees; or to forward the meeting request. You can remove the option to propose a 

new meeting time, or remove the response options entirely (for example, when sending 

a meeting request to a particularly large group of people). 
 

You can add an attendee to a meeting at any time. If this is the only change you make 

to the attendee list, Outlook gives you the option of sending an update only to the new 

attendee. 
 

Just as you can create recurring appointments and events, you can create recurring 

meetings by setting the recurrence options in the Appointment Recurrence dialog box. 

 
➤ To invite required attendees to a meeting 

  1. In the Calendar module, display the date on which you want to schedule the 

meeting. 

  2. On the Home tab, in the New group, click the New Meeting button. 
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  3. In the meeting window, enter the email addresses of the meeting attendees in the 

To box. 

  4. In the Subject box, enter the name of the meeting; and in the Location box, indicate 

where the meeting will take place. 

  5. Adjust the Start time and End time settings, and then click Send. 
 

➤ To invite an optional attendee to a meeting 

  1. On the Appointment page of the meeting window, enter the email address of the 

optional attendee in the To box. 

  2. On the Meeting tab, in the Show group, click the Scheduling Assistant button. 

  3. In the All Attendees list, click the icon immediately to the left of the optional 

attendee’s name and then, in the list, click Optional Attendee. 
 

➤ To set response options 

  1. In the meeting window, on the Meeting tab, in the Attendees group, click the 

Response Options button. 

  2. To remove the option for attendees to propose alternative meeting times, click 

Allow New Time Proposals to clear the selection of this default setting. 

  3. To remove all meeting response options, click Request Responses to clear the 

selection of this default setting. 
 

➤ To create a recurring meeting 

  1. In the meeting window, on the Meeting tab, in the Options group, click the 

Recurrence button. 

  2. In the Recurrence pattern area of the Appointment Recurrence dialog box, click 

a frequency option, and adjust settings to reflect the desired recurrence. 

  3. In the Range of recurrence area, select the appropriate end date for the series of 

meetings. Then click OK. 
 

➤ To add a meeting attendee 

  1. In the meeting window, enter the new attendee in the To box. 

  2. To the left of the To box, click the Send Update button. 

  3.  In the Send Update to Attendees dialog box, click Send updates only to added  

or deleted attendees, and then click OK. 
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Scheduling Meetings 

An important factor when scheduling a meeting with many attendees is finding a time 

that works for everyone. The Scheduling Assistant page of a meeting request window 

displays the availability of people within your organization and of people outside of 

your organization who have published their schedules to the Internet. Colored blocks 

indicate the availability of each invitee: time is shown as white (Available), blue (Busy), 

purple (Out of Office), or gray (outside of working hours). Light-blue diagonal stripes 

indicate tentatively scheduled time. Gray diagonal stripes indicate that no information 

is available (either because Outlook can’t connect to a person’s calendar or because the 

proposed meeting is further out than the scheduling information stored on the server). 

The selected meeting time is light gray bordered by green (start time) and red (end 

time) vertical bars. 
 

The All Attendees row at the top of the schedule indicates the collective schedule of all 

the invitees for the displayed time period. The calendar in the upper-right corner of the 

Scheduling Assistant page indicates the collective availability of the group by color: 
 

● Days when all attendees are available are white (Good). 

● Days when most attendees are available are light blue (Fair). 

● Days when most attendees are not available are medium blue (Poor). 

● Days that occur in the past and non-working days are gray; scheduling suggestions 

are not provided for those days. 

Selecting a date in the calendar displays suggested meeting times for that day. The avail- 

ability of required attendees is shown separately from that of optional attendees and 

resources. 
 

If your organization is running Microsoft Exchange Server 2010 or Exchange Server 2007, 

Outlook simplifies even further the process of selecting a suitable meeting time by dis- 

playing a list of suggested meeting times on the right side of the Scheduling Assistant 

page. The Suggested Times list displays meeting times of any duration you specify in the 

Duration list and indicates for each time the number of required and optional attendees 

who are available. 
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If your organization is running Exchange Server and the Exchange Server directory 

includes shared resources such as conference rooms or presentation equipment, you 

can include these resources when scheduling a meeting. 
 

 
See Also  For information about comparing multiple schedules in a horizontal Schedule  
view, see section 5 .3, “Manipulate the Calendar Pane .” 
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➤ To schedule a meeting with a message sender 

  1. In the message window or Reading Pane, point to the message sender’s name or 

email address. 

  2.  In the contact card that appears, click the View more options for interacting with  

this person button and then, in the list, click Schedule a Meeting. 

 
See Also For information about contact cards, see section 4 .1, “Create and Manipulate 
Contacts .” 

 
 

➤ To schedule a meeting with any person 

  1. In the Calendar module, display the date on which you want to schedule the meeting. 

  2. On the Home tab, in the New group, click the New Meeting button. 

  3. On the Appointment page of the meeting window, enter the meeting attendees 

in the To box. 

Or 

On the Scheduling Assistant page of the meeting window, enter the meeting 

attendees in the All Attendees list. 

 
Tip Click the To button on the Appointment page or click the Address Book button in 
the Attendees group on the Scheduling Assistant page to display the Select Attendees 
And Resources dialog box from which you can select contacts from any address book . 

 
  4. On the Appointment page, enter the meeting dates, start time, and end time in 

the appropriate boxes. 

Or 

On the Scheduling Assistant page, enter or select a meeting time. 

  5. On the Appointment page or the Scheduling Assistant page, click the Send button. 
 

➤ To use Smart Scheduling to schedule a meeting 

  1. On the Scheduling Assistant page of the meeting window, specify the required 

and optional attendees, as well as any necessary resources. 

  2. In the Suggested times list on the right side of the window, click a meeting time 

when all or most of the required attendees are available. 
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Responding to Meeting Requests 

When someone schedules a meeting with you as an attendee, Outlook sends you 

a meeting request, which you receive in your Outlook Inbox. When you receive the 

meeting request, Outlook automatically schedules the meeting on your calendar as 

Tentative. 

 

 
 

You can respond to a meeting request in one of four ways: 
 

●    Accept Outlook deletes the meeting request and shows the scheduled time on 

your calendar as the meeting organizer indicated in the meeting request. 
 

●    Tentatively accept Outlook deletes the meeting request and shows the time on 

your calendar as tentatively scheduled. 
 

●    Decline Outlook deletes the meeting request and removes the meeting from 

your calendar. 
 

●    Propose a new time Outlook sends your proposal to the meeting organizer for 

confirmation and shows the original time on your calendar as tentatively scheduled. 
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When a meeting attendee responds to a meeting request from you, you receive a meeting 

response in your Inbox. The icon and subject of the meeting response message indicate 

the attendee's response. In the meeting window, Outlook displays the number and type 

of responses from attendees in a banner below the ribbon. Either way, you always have an 

up-to-date report of how many people will be attending your meeting. 
 

If you set up a meeting that includes resources, such as a conference room, the meeting 

request sent to that resource might be automatically approved, or the person assigned 

responsibility for the resources might approve the request. 

 
➤ To accept, tentatively accept, or decline a meeting request 

  1. In the meeting request window or Reading Pane, click the Accept button, the 

Tentative button, or the Decline button. 

  2. Choose one of the following response options: 

❍    Click Edit the Response before Sending. In the meeting response window 

that opens, enter a message to the meeting organizer in the content pane, 

and then click the Send button. 

❍    Click Send the Response Now to send a standard meeting response without 

an additional message. 

❍    Click Do Not Send a Response to not send a meeting response. Your response 

will be tallied by Outlook and included in the up-to-date attendee information 

available to the meeting organizer in the meeting window. 
 

➤ To propose a new meeting time 

  1. In the meeting request window or Reading Pane, click the Propose New Time 

button, and then do one of the following: 

❍    Click Tentative and Propose New Time to mark the meeting time on your 

calendar as tentatively scheduled. 

❍    Click Decline and Propose New Time to remove the meeting from your 

calendar. 

  2. In the Propose New Time dialog box, set the proposed meeting date, start time, 

and end time, and then click the Propose Time button. 

  3. In the meeting response window that opens, enter a message to the meeting 

organizer, and then click the Send button. 
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➤ To track responses to a meeting request 

➜  In the meeting window, do one of the following: 

❍    In the information bar below the ribbon, view the tally of attendees who 

have accepted, tentatively accepted, or declined. 

❍    On the Meeting tab, in the Show group, click the Tracking button to see a 

complete list of attendees’ responses. 

 
Tip To send an email message to everyone you’ve invited to a meeting, open the 
meeting window, and click the Contact Attendees button in the Attendees group on  
the Meeting tab . Then click New E-mail To Attendees to open a blank message composi- 
tion window or Reply To All With E-mail to open a message composition window that 
contains the meeting details . 

 

 

Rescheduling and Canceling Meetings 

If it is necessary to change the date, time, or location of a meeting, you can easily do 

so in the meeting window. You can also cancel the meeting entirely. If the meeting you 

want to change is recurring, you can change an individual occurrence of the meeting or 

the entire meeting series. After you make changes, Outlook sends an updated meeting 

request to the invited attendees to keep them informed. Changes to the meeting details 

are clearly indicated. 
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If an invitee cannot attend the meeting at the scheduled time and proposes a new meeting 

time, as the organizer of the meeting, you can accept or decline the proposal. If you accept, 

Outlook updates the entry in your calendar and opens the meeting window so you can 

send an updated meeting request to the attendees. If the proposed time doesn’t work 

for you, reply to or delete the proposal. 
 

 
Tip You can specify that attendees cannot propose new meeting times .  To do this for 
all meetings, open the Outlook Options dialog box, click Calendar, and then clear the 
Allow Attendees To Propose New Times For Meetings check box .  To do it for the cur- 
rent meeting request, click Response Options in the Attendees group on the Meeting 
tab, and then clear the Allow New Time Proposals check box . 

 
 

➤ To update a one-time meeting 

  1. Double-click the meeting in the Calendar pane. 

  2. In the meeting window, make any necessary changes. 

  3. Click the Send Update button. 
 

➤ To update a recurring meeting 

  1. Double-click the meeting in the Calendar pane. 

  2. In the Open Recurring Item dialog box, click either Open this occurrence or 

Open the series, and then click OK. 

  3. In the meeting window, make any necessary changes. 

  4. Click the Send Update button. 
 

➤ To cancel a meeting 

  1. In the meeting window, on the Meeting tab, in the Actions group, click the 

Cancel Meeting button. 

  2. If the meeting is a recurring one, in the Confirm Delete dialog box, click either 

Delete this occurrence or Delete the series, and then click OK. 

  3. To inform attendees that the meeting has been canceled, click the Send 

Cancellation button. 
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➤ To accept a proposed meeting time change 

➜  In the meeting response window, in the Respond group, click Accept Proposal, 

and then click Send Update. 
 

➤ To decline a proposed meeting time 

  1. In the meeting response window, in the Respond group, click the Reply button. 

  2. In the email message, enter text to inform the attendee that you are not accepting 

the proposed time, and then click Send. 

  3. Delete the New Time Proposed message. 

 
Practice Tasks 

 

There are no practice files for these tasks. Before you begin, alert two colleagues 

that you are going to practice scheduling meetings. 
 

● Create a request for a half-hour meeting with a colleague, with the subject 

MOS Status Meeting, at 3:00 P.M. tomorrow. Enter Test – please accept as the 

location, and send the request to one person. 

● Add a second colleague as an optional attendee to the meeting request for 

the MOS Status Meeting, and then send the meeting request only to the new 

attendee. 

● Schedule a one-hour MOS Budget Meeting with two colleagues at the first 

available time next week. Set up this meeting to occur at the same time 

every month for three months. 

● Reschedule the MOS Budget Meeting to the week after next, and then send 

the updated meeting request. 

● Ask a colleague to send you a meeting request for a meeting with the subject 

MOS Project Meeting. When the meeting request arrives, tentatively accept 

the meeting and propose that the meeting be held at the same time on the 

following day. 

● Cancel the MOS Status Meeting and MOS Budget Meeting meetings and send 

cancellation notices to the attendees. 
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5 .3  Manipulate the Calendar Pane 

Arranging Calendar Content 

You can arrange the Calendar module to display specific time periods in the Calendar 

pane. The standard time periods are available from the Arrangement group on the 

View tab or the Arrange group on the Home tab. These time periods are: 
 

●    Day Displays one day at a time separated into half-hour increments. 
 

●    Work Week Displays only the days of your work week. The default work week is 

Monday through Friday from 8:00 A.M. to 5:00 P.M. Time slots that fall within the 

work week are white on the calendar; time slots outside of the work week are colored. 
 

 
See Also  For information about modifying the days and hours of the work week  
shown in Outlook, see section 1 .1, “Apply and Manipulate Outlook Program Options .” 

 
●    Week Displays one calendar week (Sunday through Saturday) at a time. 

 

●    Month Displays one calendar month at a time, as well as the preceding and follow- 

ing weeks (for a total of six weeks, the same as the Date Navigator). When displaying 

Month view, you can choose one of three detail levels: 
 

❍    Low Detail Displays a calendar that is blank except for events. 

❍    Medium Detail Displays events and shaded, unlabeled bars to indicate 

ppointments and meetings. 

❍    High Detail Displays events and labeled bars to indicate appointments and 

meetings. 

You can also display a horizontal Schedule view of one or more calendars. Schedule view 

is a new feature in Outlook 2010 that is designed to simplify the process of comparing 

short periods of time across multiple calendars. 
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➤ To change the time period displayed in the Calendar pane 

➜  On the View tab, in the Arrangement group, click the Day, Work Week, Week, or 

Month button. 
 

➤ To change the amount of information shown in Month view 

➜  On the View tab, in the Arrangement group, click the Month arrow, and then click 

Show Low Detail, Show Medium Detail, or Show High Detail. 
 

➤ To display a specific day, week, or month from the Calendar pane 

➜  In Month view, click the week tab at the left edge of a week to display only that week. 

➜  In Month, Week, or Work Week view, double-click the header of an individual day 

to display only that day. 

➜  Display the previous or next time period by clicking the Back button or the Forward 

button next to the date or date range. 

➜  Display the current day by clicking the Today button in the Go To group on the 

Home tab. 
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➤ To display a specific day, week, or month from the Date Navigator 

➜  To display a day, click that day. 

 
Tip If you’re displaying the calendar in Day, Work Week, or Week view, the day 
appears and is highlighted in the current view .  If you’re displaying the calendar  
in Month view, the display changes to Day view . 

 

 

➜  To display a week, click the margin to the left of that week. Or, if you display 

week numbers in the Date Navigator and Calendar, click the week number to 

display that week. 

 
See Also  For information about displaying week numbers, see section 1 .1, “Apply  
and Manipulate Outlook Program Options .” 

 

 
Tip  In any calendar view, selecting a week in the Date Navigator changes the display  
to Week view . 

 
➜  To display a month, click the Previous or Next button to scroll one month back or 

forward, or click the current month name and hold down the mouse button to dis- 

play a range of months, point to the month you want to display, and then release 

the mouse button. To scroll beyond the seven-month range displayed by default, 

point to the top or bottom of the month list. 

 
Tip In Month view, scrolling the month displays the entire month; in Day view, 
it displays the same date of the selected month; and in Week or Work Week 
view, it displays the same week of the selected month . 

 
 

➤ To display multiple calendars in Schedule view 

  1. On the View tab, in the Arrangement group, click the Schedule View button. 

  2. In the Navigation Pane, select the check boxes of the calendars or calendar groups 

you want to display. 

 
See Also  For information about modifying the way Outlook displays information  
in Schedule view, see section 1 .1, “Apply and Manipulate Outlook Program Options .” 
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Displaying Different Views 

The Calendar module offers four distinct views of content. These views are: 
 

●    Calendar This is the standard view in which you display your Outlook calendar. In 

the Day, Work Week, or Week arrangement, Calendar view displays the subject, 

location, and organizer (if space allows) of each appointment, meeting, or event, 

as well as the availability bar and any special icons, such as Private or Recurrence. 
 

●    Preview In the Day, Work Week, or Week arrangement, this view displays additional 

information, including information from the notes area of the appointment window, 

as space allows. 
 

●    List This list view displays all appointments, meetings, and events on your calendar. 

●    Active This list view displays only future appointments, meetings, and events. 

When working in a list view, you can group calendar items by selecting a field from the 

Arrangement gallery on the View tab. 
 

 
Tip In this book, we assume you are working in Calendar view, and refer to the standard 
Calendar view arrangements as Day view, Work Week view, Week view, and Schedule view . 

 
 

➤ To display a different view of the Calendar module 

➜  On the View tab, in the Current View group, click the Change View button, and 

then click Calendar, Preview, List, or Active. 

 

Displaying Multiple Calendars 

Secondary calendars are calendars that you create, import, or subscribe to, or that other 

people share with you. You can view secondary calendars either individually or at the same 

time as your primary calendar. You can view multiple calendars next to each other, or you 

can overlay them to display a composite view. When you view and click a date in the Date 

Navigator or scroll one calendar, all the currently displayed calendars show the same 

date or time period. 
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In the Calendar module, the Navigation Pane displays a list of the available calendars. 

You display or hide a calendar by selecting or clearing its check box. 
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In the Mail module, calendars are shown in the expanded folder list. You display a 

calendar in the Calendar module by clicking it in the folder list. 

 

 
 

If you meet frequently with the same people, you can create a calendar group that displays 

the schedules of multiple people within your organization in one place. Then any time you 

need to schedule a meeting with that group of people, you can display the calendar group 

in Schedule view, visually compare schedules, and then send a meeting request for a time 

when everyone is available. 

 
➤ To create a secondary calendar 

  1. In the Calendar module, on the Folder tab, in the New group, click the New 

Calendar button. 

  2. In the Create New Folder dialog box, name the calendar, select its location, and 

then click OK. 
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➤ To create a calendar group by choosing group members 

  1. In the Calendar module, on the Home tab, in the Manage Calendars group, click the 

Calendar Groups button and then, in the list, click Create New Calendar Group. 

  2. In the Create New Calendar Group dialog box, enter a name for the group and 

then click OK. 

  3. In the Select Name dialog box, double-click the names of the people whose calen- 

dars you want to include in the calendar group to add them to the Group Members 

box, and then click OK. 

 
Tip You can display an up-to-date group schedule at any time by selecting the check 
box of the calendar group in the Navigation Pane . You can hide the group schedule by 
clearing the check box . 

 
 

➤ To create a calendar group containing the currently displayed calendars 

  1. On the Home tab, in the Manage Calendars group, click the Calendar Groups 

button and then, in the list, click Save as New Calendar Group. 

  2. In the Create New Calendar Group dialog box, enter a name for the group and 

then click OK. 
 

➤ To delete a calendar group 

  1. In the Navigation Pane, right-click the name of the calendar group, and then click 

Delete Group. 

  2. In the confirmation dialog box, click Yes. 
 

➤ To display multiple calendars 

➜  In the Navigation Pane, select the check boxes of the calendars or calendar group 

you want to view. 
 

➤ To switch between Overlay Mode and Side-By-Side Mode 

➜  On the title bar tab of any secondary calendar, click the View in Overlay Mode 

button. In Overlay Mode, click either calendar tab to display that calendar on 

top of the other calendar. 

➜  On either of the overlaid calendars, click the View in Side-By-Side Mode button to 

return to the standard display. 
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Changing Calendar Colors 

Each calendar you display in Outlook has 1 of 15 standard colors assigned to it. The cal- 

endar color is used in the Navigation Pane, in the calendar header, and when creating 

appointments and meetings in the Calendar pane. The calendar color helps you to 

visually differentiate between calendars, and is especially useful when viewing multiple 

calendars in Overlay Mode. By default, Outlook automatically assigns a color to each 

new calendar that is different from the colors of existing calendars. You can change the 

color of any calendar. 

 
➤ To change a calendar color 

  1. Display the calendar for which you want to change the color. If you’re displaying 

multiple calendars, select the calendar you want to change by clicking its tab. 

  2. On the View tab, in the Color group, click the Color button. Then in the Color 

gallery, click the color you want to assign to the calendar. 
 

 

Practice Tasks 
 

There are no practice files for these tasks. Before you begin, alert a colleague that 

you are going to practice sharing your calendar. 
 

● Display the calendar for next month. By clicking in the Calendar pane, dis- 

play only the second week of the month. By clicking in the Date Navigator, 

display only the fifteenth day of the month. 

● Create a secondary calendar named MOS Schedule, and display it beside your 

primary calendar. 

● Change the color of the MOS Schedule calendar to one of your choosing. 

● Create a calendar group named MOS Team that includes the secondary 

calendar and the calendar of a colleague, and display the calendar group 

in Schedule view. 

● Display the MOS Team calendar group in Overlay Mode. 

● Delete the MOS Team calendar group. 

● Hide the MOS Schedule calendar. 
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Objective Review 
 

Before finishing this chapter, ensure that you have mastered the following skills: 
 

5.1   Create and Manipulate Appointments and Events 

5.2   Create and Manipulate Meeting Requests 

5.3   Manipulate the Calendar Pane 
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